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1.  Introduction 

Nuclear Medicine imaging is fast growing, but the challenges of interpretation for efficient diagnosis have been its setbacks over the 

years. Due to these challenges, Clinicians do not make optimal use of the information acquired by an imaging device (Lusted, 1960). 

The imperfections of the human eye-brain system, insufficient training and experience, challenges such as lack of concentration, 

stress, distraction and environment may all add-up to suboptimal use of available information (Kundel & Revesz, 1976). Image 
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Abstract: 
Computer-aided diagnosis (CAD) using Image J software has been used to quantify myocardial infarct (MI) area. The study 

was designed to develop an algorithm for thresholding of myocardial perfusion SPECT image, and estimate an area with 

possible myocardial infarction from region with normal perfusion. The objective of this paper is to determine the accuracy 

of ImageJ algorithm for quantification of myocardial infarct area using SPECT images.  

A phantom consists of a large container to mimic the human body. With a small cylindrical container inserted in the large 

container to simulate the heart, inside the small cylindrical container, a silicon rubber and some defects (40 mm
2
 each) were 

placed to mimic the heart Myocardium and perfusion defects. A 
99m

Tc – tagged (0.6 ml) radioisotope was mixed with water 

in the large container for background solution, the small cylindrical container was also filled with water and mixed with 
99m

Tc – tagged (0.25 ml) radioisotopes, SPECT images were acquired and reconstructed with FBP technique using the 

Butterworth filter cut off frequency 0.4cm
-1

 and order of 10. MI was quantified before and after thresholding using Image J 

software. 

Overestimation of defect area was observed from the image without thresholding, with estimated mean area and standard 

deviation of about 273.93mm
2
±	28.088, in comparison with the thresholded image with 38.09mm

2
±0. 657.The thresholded 

image almost approximate the actual infarct size. At 0 cm position, the mean area and standard deviation were 33.51 mm
2 

±	0.436, and at the 10 cm position is about 38.09mm
2
	±0.657. At 10 cm position, the defects areas almost approximate the 

actual infarcts size. We compare the mean area of the two positions using the paired t-test, a p-value of <0.001 was 

estimated, which indicates a strong statistical significance difference. The results indicate that, thresholding using ImageJ 

software not only aid in accurate infarcts quantitation, it also increases the signal to noise ratio, which enhances the 

contrast of the region of interest.  

 

Keywords: Image J, Computer-aided diagnosis, SPECT, Myocardial infarction, Phantom, thresholding, Filtered back 

projection 
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processing techniques can be employed to medical images with the intent to address some of these challenges. Medical image 

processing attempts to enhance the image presented to the readers in such a manner that abnormalities are enhanced for the reader to 

appreciate it. However, image processing alone cannot completely address these challenges such as inexperience and lack of 

concentration. Computer-aided diagnosis (CAD) systems applied to medical images suffice image processing, that is to say, they may 

provide specific lesion location information and/or other diagnostic analysis to assist clinicians. 

The main objectives of computer-aided diagnostic system are to systematically identify areas in an image that may bring to light 

specific aberration and inform the expert to these locations during image interpretation. In addition, CAD system assists the clinician 

to exactly know the extent and progression of disease, in other to quantify and assess disease type, severity and stage of the disease 

(Doi, 2007). 

The main objective of this paper is to determine the accuracy of ImageJ algorithm for quantification of myocardial infarct area, using 

SPECT images. ImageJ software have demonstrated to be valuable and reliable software for image analysis, is a public domain Java 

image processing and analysis program inspired by National Institutes of Health (NIH), United States of America which is freely 

available and operates on a range of platforms such as Windows, Mac, and Linux for image processing (Collins, 2007). It can 

calculate area and pixel value statistics of user-defined selections. It can measure distances and angles. It can create density histograms 

and line profile plots. It supports standard image processing functions such as contrast manipulation, sharpening, smoothing, edge 

detection and Median filtering (Pedersen, Steinkuhler, Wesser, & Rotilio, 2011). ImageJ software can read different file formats 

(without the need of third-party plugins), it opens the following formats: TIFF, GIF, JPEG, PNG, DICOM, BMP, PGM and FITS. 

(Hartig, 2013). 

With ImageJ software, thresholding is one of the unique methods in separating pixels which fall in between a desired range of 

intensity values from those which do not, (also known as ‘segmentation’). In the ideal world, the pixel intensity values of the areas 

you are interested in will be a unique subsection of the image; this will assist in distinguishing benign region from normal. The 

variability of human internal organs in density is what is exploited in general Radio-diagnostic, including nuclear medicine, this 

unevenness in tissue density will result in different absorption characteristics of the tissue to radiation, and this will lead different pixel 

intensities in different region inside our body structure. Selecting a particular pixel intensities and thresholding will lead to the 

subtraction of some range of pixel intensity intensities while enhancing and analyzing the selected Region of Interest (ROI). 

Quantification of ROI is also possible to ascertain or estimate the area of deficit in terms myocardial infarction.  

Single photon emission computed tomography (SPECT) perfusion imaging has been considered a reference method for non-invasive 

estimation of infarct size in man. Computer aided diagnostic has evolved as an accurate tool to quantify infarct size. SPECT images 

have challenges of inherent noise due to attenuation and scattering of radiation, these challenges affect the interpretation of nuclear 

medicine images, with the development of hybrid imaging systems, i.e., SPECT/CT, apart from anatomical mapping, CT also takes 

care of the attenuation, which reduces the noises that may affect image quality.  

The gamma camera, invented by Anger in the 1950, is a device for imaging the spatial distribution of a radionuclide in an object. The 

technique can be used for obtaining planar images as well as for tomographic imaging, where a number of projections in different 

angels of the object are collected and a three dimensional volume is obtained through either filtered back projection or an iterative 

method such as Maximum Likelihood Expectation Maximization (MLEM) or Ordered Subsets Expectation Maximization (OSEM). 

The iterative methods may also incorporate compensations for attenuation, scattering and collimator response as a part of the 

reconstruction. The tomographic use of the camera is often referred to as Single Photon Emission Computed Tomography, or SPECT. 

Myocardial perfusion imaging (MPI) is a generally used diagnostic method for handling of patients with suspected or known ischemic 

heart disease(Hachamovitch et al., 1996; Underwood et al., 2004). In Nuclear medicine, analysis of MPI relies on the knowledge of 

the clinicians, and is subject to inter and intra-observer variability(Lindahl, Lanke, Lundin, Palmer, & Edenbrandt, 1999).  

 
1.1. Basic Principles of Cardiac SPECT Imaging 

 

1.1.1. Myocardium Data Acquisition 

SPECT provides three-dimensional images that facilitate both a visual and a quantitative evaluation of the cardiac radionuclide 

distribution and of the surrounding tissues by removing superimposed activity from surrounding tissues(DePuey & Rozanski, 1995). 

The administered radioisotope in the patient’s body emits single gamma ray photons that are recorded through a gamma camera 

mounted on a gantry in numerous projections around the patient. Both contour and elliptical orbits can be used. The projection 

acquisition may be performed in three different ways: step-and-shoot, continuous, and continuous step-and-shoot. The method mostly 

used is the step-and-shoot method. For a given orbit, the camera stops at predefined angular positions and acquires a projection for 

predefined time durations. An arc of 180 degrees is usually covered, that is, 45 degrees right anterior oblique to left posterior oblique 

(RAO-LPO) (DePuey & Rozanski, 1995). Equal times are used to achieve the same count statistics. Another parameter that greatly 

affects the image quality (sensitivity and resolution) is the choice of the collimator. This is determined mainly by the tracer activity. 

When 
201

Tl is being used a low-energy general purpose collimator is traditionally chosen. For 
99

Tc-labeled agents high resolution 

collimators are recommended, whereas for
111

In and 
123

I MIBG (metaiodobenzyl guanidine) medium energy collimators are usually 

used (DePuey & Rozanski, 1995) 

Other important parameters that are to be taken into account during acquisition are the projection matrix size, the number of angles, 

and the time per view. For the projection matrix, a common rule of thumb is that at least three pixels should be used to image a 

structure for each full width at half maximum (FWHM) of the response profile. For the number of angles the time per view determines 

the statistical content of the projected image. The interrelationship of these parameters is quite complicated. In most cardiac SPECT 
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protocols, a 180
o
 camera rotation with 64×64 matrix size is recommended (Germano, 2001). The 2D projection-images are first 

corrected for non-uniformities and then mathematical algorithms are used to reconstruct 3-D matrices of selected planes from the 2-D 

projection data. 

 

1.2. Myocardium Image Reconstruction Techniques 

 The purpose of reconstruction algorithms is to calculate an accurate 3-D radioactivity distribution from the acquired projections. 

There are two methods to reconstruct SPECT images, either by filter back projection (FBP) analytical technique or iteratively, by 

algebraic methods. 

 

1.2.1. Filtered Back Projection Method (FBP) 

Filtered back projection is an analytical method that is still the most widely used in clinical SPECT because of its simplicity, speed, 

and computational efficiency. FBP consists of two steps: Filtering of data and back projection of the filtered data(S. Cherry, Sorenson, 

& Phelps, 2003). In 2-D acquisition, each row of projections represents the sum of all counts along a straight line through the depth of 

the object being imaged. Back projection technique redistributes the number of counts at each particular point back along a line from 

which they were originally detected. This process is repeated for all pixels and all angles. A limited number of projection sets can 

result in the formation of the star artifact and in blurring of the image. To eliminate this problem, the projections are filtered before 

being back projected onto the image matrix. It has to be noticed that the back projection process has taken place in spatial domain 

while data filtration is done in the frequency domain. While the analytic approaches typically result in fast reconstruction algorithms, 

accuracy of the reconstructed images is limited by the approximations in the line-integral model on which the reconstruction formulae 

are based(Qi & Leahy, 2006).Cardiac SPECT reconstruction process may obtain attenuation corrections approximately, using a post 

processing step (Chang, 1978). Some reconstruction algorithms apply approximation formulas to the projection data for attenuation 

correction. Lee –Tzuu (Chang, 1978) applied a simple, effective two-step procedure to the uncorrected image. For two-dimensional 

(2-D) SPECT with Parallel or fan beam collimators, 2-D filtered back projection (FBP) algorithms are routinely used for myocardium 

SPECT reconstruction. 

 

1.2.2. Iterative Reconstruction Method 

Iterative reconstruction starts with an initial estimate of the image (S. R. Cherry, Sorenson, & Phelps, 2012). Most of the times, the 

initial estimate is very simple, for example, a uniform activity distribution. Then a set of projection data is estimated from the initial 

estimate using a mathematical process called forward projection. The resulting projections are compared with the recorded projections 

and the differences between the two are used to update the estimated image. The iterative process is repeated until the differences 

between the calculated and measured data are smaller than a specified preselected value. For 3-D SPECT, the iterative reconstruction 

methods include algebraic methods like the algebraic reconstruction technique (ART) and statistical algorithms like MLEM or OSEM 

(Bruyant, 2002). The MLEM algorithm is a general approach to solving maximum likely hood problems through the introduction of a 

set of data which, if observed, would make the ML problem readily solvable. The algorithm then iterates between computing the mean 

of the complete data, given the observed data and the current estimate of the image, and maximizing the probability of the complete 

data over the image space. In the ordered subsets EM (OSEM) method the full set of views is divided in to subsets and the EM 

algorithm applied sequentially to each of these data sets in turn. This produces remarkable improvements in the initial convergence 

rate compared to MLEM (Qi & Leahy, 2006). 

 

1.3. Image Filtering in Cardiac SPECT 

Different filter types in SPECT imaging can produce different optimal results in processed images, such as star artifact reduction, 

noise suppression, or signal enhancement and restoration (Van Laere, Koole, Lemahieu, & Dierckx, 2001). The choice of filter for a 

given image processing task is generally a compromise between the extent of noise reduction, fine detail suppression, and contrast 

enhancement, as well as the spatial frequency pattern of the image data of interest. Filters that are commonly used on SPECT imaging 

are the Ramp filter, a high pass filter eliminating the star artifact and blurring, the Hanning filter, a low pass smoothing filter, the 

Hamming filter, also a low pass smoothing filter having a different amplitude at the cut off frequency, the Butterworth filter, which 

both smoothers noise and preserves the image resolution, the Parzen filter, the most smoothing low pass filter, and the Shepp-Logan 

filter, which is the least smoothing but has the highest resolution (Van Laere et al., 2001). Two enhancement filters also used in 

cardiac SPECT are the Metz filter, a function of modulation transfer function and the Wiener filter, which his based on the signal-to-

noise ratio of the specific image. A more extensive presentation of all the mentioned filters can be found in “Filtering in SPECT Image 

reconstruction” (Lyra & Ploussi, 2011). 

 

2. Materials and Methods 

 

2.1. SPECT/CT 

SPECT/CT General Electric (G.E) Discovery (NM/670) (Fig. 1) was used in this study, with a dual headed gamma-Camera and a low-

dose 16-slice CT are mounted on the same Rotation platform. The CT operates at 120 KV-100 mA for purpose of attenuation 

correction and image registration, with a 0.5 sec rotational speed scanning time to acquire a 40 x 54 cm axial field of view, and the 

20mm (4 × 5 mm) axial coverage per CT slice best matches SPECT resolution. The SPECT detector consists of 3/8 inch. NaI crystal, 
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electrically coupled with 59 Photo-Multiplier tubes (PMT), 1 Analog/Digital converter/PMT (1 ADC/PMT). Spatial resolution with 

Low Energy High Resolution (LEHR) Collimator of 7.4, with 24 rows maximum 16 slices/rotation time in spiral mode.  

 

 
Figure 1: SPECT/CT BY G.E discovery model NM/CT670 

 

2.2. Phantom 

A polystyrene phantom was designed to mimic the myocardial perfusion study of a human, featuring an insert to simulate the human 

heart. The larger container/tank is made up of polystyrene whereas the insert is made up of silicon rubber enclose in a small 

cylindrical container made up of polystyrene, enclose in the small cylindrical container are defects attach to the silicon rubber to 

simulate perfusion defects, the defect were made from a soft plastic, 4 cm
2
 (40 mm

2
) each. The phantom and the cardiac insert are 

designed to mimic myocardial perfusion study (Myocardial infarction) as shown in Fig. 2 below. 

 

 
Figure 2: Polystyrene phantom to mimic myocardial perfusion studies (to study simulate myocardial infarction) 

 

2.3. ImageJ Software 

ImageJ software is application software built by Wayne Rasband, National Institutes of Health (NHI) United States of America which 

is freely available and operates on a range of platforms such as Windows, Mac, and Linux for image processing. The software can be 

employed to calculate various statistical parameters (i.e., mean, standard deviation, integrated density etc.) and can be used for 

quantification purpose, by thresholding and other selecting tools. 

 

2.4. SPSS 21 

SPSS 21.0 (SPSS Inc., Chicago, Illinois) is been used in this study, SPSS 21 is a comprehensive system for analyzing data. SPSS 

Statistics can take data from almost any type of file and use them to generate tabulated reports, charts, and plots of distributions and 

trends, descriptive statistics, and complex statistical analyses. SPSS Statistics makes statistical analysis more accessible for the 

beginner and more convenient for the experienced user. Simple menus and dialog box selections make it possible to perform Complex 

analyses without typing a single line of command syntax. The Data Editor offers a Simple and efficient spread sheet-like facility for 

entering data and browsing the working data file. 
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3. Methodology 

 

3.1. SPECT Image Acquisition 

Images were taken at an arc of 180 degrees, that is 45 degrees right anterior oblique to left posterior oblique (RAO-LPO).The imaging 

was performed using a hybrid double-head SPECT/CT camera [model GE Discovery dual headed SPECT/CT (NM/CT 670)] in A 

90°geometry equipped with low-energy high resolution parallel-hole Collimators designed. The phantom was scan, and images were 

recorded over 180° in 256 x 256 matrices With an acquisition time of 20s per projection in 3° increments using the step and shoot 

mode, resulting in a total of 60 projections . The matrix used at 0 cm and 10 cm locations was 256 x 256. An energy window was 

centered on 140 kev±	20% with a pixel size of 6.8 mm, planar image was the modality used. A stress perfusion imaging study was 

conducted (Fig 4), reconstructed By FBP (Filtered back projection) using the Butterworth filter cut off frequency 0.4 cm
-1

 and order of 

10 as a processing filter. Radiation transmission radionuclide was the mode of attenuation and scatter correction.  Data acquired by GE 

Discovery dual headed SPECT/CT (NM/CT 670) and reconstructed in Nuclear Medicine unit, AMDI [Advanced Medical and dental 

institute (IPPT)], University of Science Malaysia (USM).  

 

 
Figure 3: Phantom positioned at the center of the table while acquiring SPECT images 

 

3.2. Image thresholding and Measurement of infarcts area using ImageJ Software 

Thresholding works by separating pixels which fall within a desired range of intensity values from those which do not. The images 

reconstructed were selected from the vertical axis, five slices were selected from 0 cm, and 10 cm positions, the images are in DICOM 

format, in RGB (Red, Green and blue channel) color image, colors were assigned to perfused areas, less perfused areas and defected 

areas, example from fig 4, the white region was assigned to high perfused areas, yellow region were the sparsely perfused and blue 

region were the defected areas. To threshold the image in other to enhance defect area, RGB color image is converted in to 8 bits (gray 

scale), from the imageJ application tool bar, use Image> Type>8 bits. In 8 bit- grey scale, a pixel with an intensity of 0 is black, a 

pixel with a value of 255 is white, everything in between is a shade of grey. Inspecting the region of interest to check the average 

range of intensities in the region will assist during thresholding, in this study its around 128-pixel intensity or grey value. 

Segmentation (thresholding) involve the following, from the imageJ application tool bar, by using Image>Adjust>Threshold (or ctrl + 

shift+ t). The gate for the intensities measured can be adjusted by changing the minimum and maximum sliders, as shown from fig. 5. 

The values correspond to the pixel intensity value (0 = black and 255 = white in an 8 bit image).  Adjust the values of the threshold 

until the region of interest is selected, adjusting the maximum and minimum sliders to 128, the defected area will be highlighted while 

the remaining pixel intensities will be subtracted from the image. Now, to measure the defected area, the average intensity  and any 

other parameter of interest, be careful not to press “Apply” as this will make your image binary (i.e. black and white) and the red 

intensities information will be lost. To make measurements, set measurements and pick what you want in the set measurements 

window by ticking the box. Make sure that ‘Limit to Threshold’ is checked and ticked. If not all of the image will be measured. Scale 

need to be set, which  before measuring the parameters, meaning to set the pixel values in to milli meter (mm), in this study its 6.8 

pixel per mm. Make sure there is enough decimal places for accuracy. Once the measurements are set and the threshold is in place the 

SPECT image can be measured. This is done by going to Analyze >Measure, from the imageJ tool bar.  The results of parameters 

selected will be displayed, and then you save it. 
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Figure 4: A stress perfusion imaging study, reconstructed by FBP using Butterworth filter 

 

 

 
 

Figure 5: Example of thresholded image, the red color shade area is the defected area, whereas the white region is the highly perfused area 

 

3.3. Statistical Analysis 

Analyses were performed using SPSS 21 (SPSS Inc, Chicago, Illinois). Two tailed P values were used with P ≤ 0.05 considered to 

indicate statistical significance. Or data are presented as mean ± SD. One or two tailed (when appropriate) paired t-test were used to 

compare count activity between the images with or without thresholding. A P value < 0.05 was considered statistical significant. 

 

4.  Results and Discussions 

 

4.1. Comparison between Measurement with Thresholding and without Thresholding 

The table 1 below is the estimated area of defects, calculated using ImageJ software, before and after digital processes (thresholding).  

      

With thresholding(mm
2
) No-thresholding/Raw data (mm

2
) 

37.327 313.365 

37.543 273.659 

38.214 266.263 

38.495 235.316 

38.906 281.055 

Table1: estimated area from ImageJ of the thresholded and unthresholded data 

 

Fig 6 below, are the five selected images that were digitally processed using ImageJ, the red color region is the defected area, whereas 

the white region are the highly perfused area. 

 

 

 
 

Figure 6: Thresholded image at 10 cm positioning of the phantom 

 

Fig 7 below, are the same five selected images as in fig 6, the blue area in the image, is the defected area, the images also represents a 

raw data. 
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Figure 7: Unthresholded image (raw data) at 10 cm positioning of the phantom 

 

Paired Samples Statistics 

 Mean N Std. Deviation Std. Error Mean 

Pair 1 mean1 38.09700 5 .656961 .293802 

mean2 273.93160 5 28.088174 12.561413 

Table 2: mean area of the thresholded and unthresholded image calculated by SPSS 21 

 

4.2. Discussion 

The estimated area of perfusion defects in the reconstructed SPECT image is recorded in table 1, ImageJ was used to analyze and 

estimate the defects area for both thresholded and un-thresholded (raw data) image. Five different slices from the vertical-axis were 

chosen from the SPECT reconstructed images at 10 cm position. 

 The images were analyze before and after thresholding using ImageJ algorithm, the mean estimated area for the thresholded image 

were close to the actual size of the defects (40 mm
2
), in comparison to the raw data, this could be due to image noises as a result 

scatter and attenuation of photons in the un-thresholded image.  

 From table 1, the estimated area of the slices selected varied a little; as an examining organ has certain dimensions, each slice along 

the axis of the gamma camera has different distance from the detector. Thus, each photon experiences different attenuation. These two 

phenomena usually lead to distortion of the measured activity concentration; this could be due to the slice thickness (1.70 mm) chosen 

during image reconstruction.   

Another factor that could be responsible to the high noise in the un-thresholded image is the image reconstruction that was used. 

Filtered back projection (FBP) ignores physical phenomenon such as scatter and attenuation correction, which can cause significant 

image degradation. The quality of the myocardium SPECT images is degraded by several factors. The most important factors affecting 

image quality of myocardial perfusion SPECT are the statistical fluctuation in photon detection, the attenuation of photons and the 

scatter radiation. The reason for this is the fact that gamma rays have to travel some distance in a fluid media. This media attenuates 

and scattered the gamma radiation, the gammas being emitted actually get outside the body after traveling some distance in water. The 

further away the activity has to travel the greater the amount of attenuation occurs. Radiations are scattered in the phantom, and the 

scattered photons, depending on the energy and angle of scattering, may strike the detector. Scattering may occur in the detector itself, 

and also within or outside the FOV. Normally, most of these scattered photons fall outside the photopeak window and are rejected. 

However, a fraction whose photon energy falls within the photopeak window will be counted, but their (X, Y) positions remain 

uncertain causing degradation of the image resolution. 

In addition to attenuation resulting in degrading the image quality which resulted in the increase of noise to the un-thresholded image, 

a significant fraction of the detected photons are scattered in the object. This is due to the finite energy resolution of the gamma 

camera, which results in imperfect energy based scatter rejection. The scatter to primary ratio (SPR) depends on the radionuclide, 

energy window, energy resolution, source depth and the size of the object. Scatter results in loss of contrast and quantitative accuracy. 

For an organ inside the patient body, SPR is in general greater for patients with large size than small size. Photons emitted from the 

organ have longer photon path in large patients than small patients, thus have higher probability to be scattered, and consequently SPR 

can be greater. The SPR increases approximately linearly with source depth, so the quantitative effects of scatter are larger for source 

positions near the centre of the object. 

Radionuclide transmission sources was the method used for attenuation correction, some of the disadvantages that results in using 

such modality includes, the fact that the source decays and must be replaced. There are also limits on transmission count rates imposed 

by the gamma camera, resulting in relatively noisy transmission images. In addition, if the count rate due to the emission activity 

within the object is high, the transmission images can be degraded, resulting in inaccurate attenuation maps and consequently noisy 

image. 

From table 2: SPSS 21 was used to calculate and compare the two means, i.e., mean area for the thresholded and un-thresholded 

image, the mean and standard deviation were 38.09 ± 0.657 mm
2
 (for thresholded) and 273.9 ±	28.088 mm

2
 (non thresholded). 

The standard deviation (SD) is the measure of the signal to noise ratio, the higher the SD, the lower the signal to noise ratio, the 

thresholded image will have a better signal to noise ratio, because it has a lower standard deviation 0f ±	0.657 in comparison with the 

raw data with standard deviation of± 28.088 which may result in better contrast for the thresholded image. The P-value is < 0.001, 

which indicates a strong statistical significant difference between the two means. 
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4.2.1. Comparison between Estimated Areas at Two Different Positioning of the Phantom 

Table 3 below is the estimated area of defect calculated using ImageJ software, after thresholding for 0 and 10cm positioning of the 

phantom on the imaging table. 

 

0 cm phantom position (mm
2
) 10 cm phantom position (mm

2
) 

33.499 37.327 

34.040 37.543 

32.894 38.214 

33.780 38.495 

33.348 38.906 

Table 3 

 

Fig 8 and 9 below, are the five selected images that were digitally processed using imageJ software, at the 0 and 10 cm positioning of 

the phantom, the red color region is the defected area, whereas the white region are the highly perfused area. 

 

 

 
 

Figure 8: Five selected slices of images at 0 cm position of the phantom, at vertical axis (thresholded) 

 

 

 
 

Figure 9: Five selected slices at 10 cm position of the phantom, at vertical axis (thresholded) 

 

Paired Samples Statistics 

 Mean N Std. Deviation Std. Error Mean 

Pair 1 mean1 33.51220 5 .435774 .194884 

mean2 38.09700 5 .656961 .293802 

Table 4: mean of the 0 and 10 cm positioning of the phantom calculated by SPSS 21 

 

4.3. Discussion 

From table 3 above, the estimated area of the MI defects were calculated using imageJ for different positions of the phantom on the 

table couch and were recorded respectively. Five slices were selected just as in 4.1 above. Comparing the mean estimated area of the 

two positions, the position of the phantom at 10 cm gives an estimated area closer the actual size of the MI defect, which is about 

38.09700	±0.65696 in comparison with the 0 cm position of 33.51 mm
2
±	0.4358. 

The underestimation of the estimated defect area at the 0 cm position could be as a result of attenuation/scatter factors which are 

dependent on source to collimator face distance. Images obtained with a gamma camera are degraded by the spatially varying 

collimator–detector response (CDR). For parallel-hole collimators, the CDR depends approximately linearly on the distance from the 

collimator face. The CDR has geometric, septal penetration and septal scatter components. These correspond, respectively, to photons 

passing through the collimator holes, photons passing through the septa without interacting, and photons scattering in the septa and 

resulting in a detected photon. The latter two effects tend to reduce image contrast, can produce star artifacts and introduce distance 

dependent sensitivity variations, and consequently, attenuate the photon intensity, which may reduce or underestimate the radionuclide 

distribution in the defected area.  

From table 4, SPSS 21 was used to calculate and compare the two means, i.e., mean area for both the thresholded images at 0 and 10 

cm position of the phantom on the table, the calculated mean and standard deviation were 33.51 ±0.436	mm
2 

for  and 38.09 

mm
2
±	0.657. The P-value is < 0.001, which indicates a strong statistical significant difference between the two means. 

 

5. Conclusion 

The results show that accurate quantitation of relative infarct size is possible, with the aid of ImageJ software by thresholding to 

distinguish an area with a defect from an area without a defect. By thresholding, the defected area was measured which almost 

approximate the actual size of the defects area. SPECT using a 
99m

TC – tagged radioisotope can accurately measure myocardial 
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defects (MI). Thresholding not only aid in accurate infarcts quantitation, it also increases the signal to noise ratio, which enhances the 

contrast of the region of interest. 

Accurate or optimum positioning of the heart as demonstrated by the phantom study can aid in determining actual infarcts size. This 

was attributed to the positioning of the phantom on the imaging table. Positioning the phantom far from the collimator face could 

degrade the image quality due to attenuation and scatter of radiation, which may result in underestimating the estimated infarcts area. 

Reconstruction algorithm (FBP) used in this study ignores attenuation and scatter correction, which resulted in image degradation and 

image noise. Radionuclide transmission method used for photon attenuation correction is not ideal, because it gives a disappointing 

result. 

Paired t-test was done using SPSS 21, which indicates a strong statistical significance difference between the raw data and the 

thresholded data. The estimated mean of the two different positioning of the phantom also shows a statistical significance difference.   

 

6. Limitations on the Phantom Studies 
Our study had several limitations. First, phantom images may not closely mimic human myocardial infarctions. The bigger tank which 

contains the background solution, cannot mimic actual human body, because the internal organs of the human body is made up of 

different tissues, with different densities, and so will results in different mode of attenuation and scattering of radiation. Secondly, all 

acquisitions and data points derive from a single phantom source and activity – loading. For clinical application, many additional 

factors such as motion and patient-induced scatter may complicate corrections and degrade image quality, and in vivo studies are 

warranted.  
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